presented a workshop on “Effective Leadership for the 21st Century.” The challenge
of leadership and diversity in a pluralistic
society was outlined by Dr. Lea who included results from an ongoing study on
teacher attitudes on multiculturalism. The
material was also presented to the School
of Education faculty and in a new video
series, “Worth Talking About” which is distributed to school administrators across
Tennessee.
Doug Lepter
Doug attended the annual National Communication Association Convention in San
Diego, CA. While there he enrolled in a
“short course” on teaching media ethics
that was led by a panel of experts/authors
in that area. The material is directly applicable to the course in mass communication
ethics that he teaches. He attended several
scholarly paper panels that stimulated research and course material reflection
Kathy Mowry
Kathy has been asked to present at the
Global Mission Conference in Orlando at
the Church of the Nazarene General Assembly this summer, June 24-28. One of
the major benefits would be networking
with missionaries and those in mission
leadership as well as other professors of
mission. Since most of the presenters are
from other world areas, she anticipates
gleaning much of the international perspective on missions and current needs/
issues to enhance her classroom teaching.
Richard Parrott
Drs. Cox, Lea, and Parrott attended the
AACTE convention in Chicago. Together,
they presented a workshop on “Effective

Leadership for the 21st Century.” Dr. Parrott
presented a teaching and learning method for
increasing effectiveness in professional reflection. The material was also presented to the
School of Education faculty and in a new
video series, “Worth Talking About” which is
distributed to school administrators across
Tennessee.

Trevecca
Nazarene
University

Prilla Speer
The Minigrant helped fund a trip to Seattle to
attend ACRL [Association of College & Research Libraries] conference. The many sessions and workshops attended provided opportunities to network with colleagues and to
keep abreast of latest trends and technology
services in academic libraries.
Sam Stueckle
Sam attended the Joint Mathematics Meetings of the AMS and MAA in Washington, DC,
January 4-8. He took 3 students to the meetings, attended numerous mathematical talks,
and attended a mini-course on mathematical
biology, where he learned some valuable tools
for the next time he teaches one of the mathematical models in biology courses.

Mini-Grant
recipients
2008-09

Marcia Walker
Marcia presented her research at the Council
for Exceptional Children National Conference.
Her work researches the usage of paraprofessionals in the regular education classroom.
The research focuses on the training, educational level, criteria used to hire paraprofessionals, assignment in schools, roles of paraprofessionals in the regular education classroom, and measuring their effectiveness by
studying the students they are working with
one-on-one. The benefits of this research will
help local school districts make informative
decisions when utilizing paraprofessionals in
their regular education classrooms. 

Faculty
Development
Committee

James Agee

across Tennessee.

Jae presented a paper entitled
“Evaluating Faith Integration in the
Classroom: The Validity of End-of-Course
Evaluations” at the Christian Business
Faculty Association conference. It was a
statistical analysis of the construct validity of end-of-course evaluations. It was
aimed at discussing and developing ways
to evaluate faith integration in the classroom. The paper generated a rather interesting discussion in the session in which it
was presented..

David Diehl

Ed Anthony
Ed attended the Christian Business Faculty Association (CBFA) conference in Indianapolis. It was a great time to fellowship with colleagues, share and receive
insights, and receive professional and personal edification from attending some
great conference sessions. Several new
contacts in the areas of IT and personal
finance were developed which should
prove helpful in generating new ideas and
furthering the mission of the business department and Trevecca.
Ruth Cox
Drs. Cox, Lea, and Parrott attended the
AACTE (American Association
for Colleges of Teacher Education) convention in Chicago. Together, they presented
a workshop on “Effective Leadership for
the 21st Century.” Dr Cox’s presentation
provided clear methods and systems for
managing and improving communication.
The material was also presented to the
School of Education faculty and in a new
video series, “Worth Talking About” which
is distributed to school administrators

David attended the annual National Association of Schools of Music (NASM) meeting in
Seattle, Washington November 21-24. Attendance at this conference supported the work
of curriculum revision in the Div. of Music.
Bryce Fox
Bryce will be presenting two workshops for
the General Church of the Nazarene in Orlando, Florida this summer at their General
Assembly. The titles of the two workshops
are: “Diaries, Sex and Young Adult Christians: Secrets from the Past, Compromises
for the Present, Pain for the Future” and
“Young Adults: From Faithful, To Fleeting…
A Time for Action: The church’s unprecedented opportunity to bring back and keep a
‘Disillusioned Generation’”.

sional workshops and interacting with colleagues from other areas of the country and
other Christian academic programs.
Graham Hillard
Graham attended the Association of Writers
and Writing Programs (AWP) conference in
Chicago, the premier conference for teachers of
Creative Writing. His essay “Hearing the
Words: Thoughts on Developing Rhythm” was
accepted for presentation at the AWP Pedagogy
Forum.
Steve Hoskins

The Minigrant helped fund my attendance to
the Association of College and Research Libraries conference in Seattle, WA. The workshops and conference sessions were valuable
experiences in that they provided inspiration, tools, and strategies to help her meet
the changing needs of faculty & students.

Steve used his mini-grant to fund a trip to the
Wesleyan Theological Society Meeting at
Anderson University in Anderson, IN where he
presented a paper about the Church of the
Nazarene's ministry to the poor on a panel celebrating the Centennial Anniversary of the
founding of the Church of the Nazarene. He
also attended a meeting of historians who are
sharing their research on the founding of the
Church of the Nazarene in a book of essays
about Phineas Bresee and his relationships
with other holiness movement leaders that will
be published by Point Loma University
Press. Steve is writing the chapter on Bresee
and the founder of Trevecca, J.O. McClurkan
for that volume.

Don Harvey

Dusteen Knotts

Don presented a professional workshop at
the International Conference for the Christian Association for Psychological Studies
(CAPS) in Orlando, Florida. An upfront presence at professional meetings of this type
positively promotes Trevecca Nazarene University in general and specifically the programs offered through the graduate psychology program. Don also benefited personally
and professionally by attending other profes-

Dusteen spoke at The Learning Disabilities of
America National Conference on the topic: Effective use of Paraprofessionals in inclusion
classes. She is currently researching this topic
and hopes to work collaboratively with local
schools in implementing the methods proposed.

Annette Harber

Karen Lea
Drs. Cox, Lea, and Parrott attended the
AACTE convention in Chicago. Together, they
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The Ribbon
Microsoft Office 2007 provides easy access to commands through the Ribbon, which replaces the menus and toolbars found in previous versions. The
purpose of the Ribbon is to keep commands visible while you work instead of hiding them under menus and toolbars.
Contextual tab

Command tabs

Dialog Box Launcher

Group

Help button

Gallery

• Command tabs: Appear by default whenever you open a Microsoft Office

• Group: To make things easier to find, the commands on each tab are

• Contextual tabs: Appear whenever you perform a specific task and offer

• Gallery: A set of thumbnail graphics that represent the result of applying a

• Dialog Box Launcher: Click to display a dialog box or task pane.

• Help button: Click to display the new Help window.

program. Click on a tab to view its available commands.
commands relative to only that task.

organized into groups of related commands.
series of formatting commands.

Microsoft Office Button

Quick Access Toolbar

The Microsoft Office Button, located in the upper left-hand corner of the program window, replaces the
File menu found in previous versions of Microsoft Office. The Microsoft Office Button menu contains
basic file management commands, including New, Open, Save, and Close.

The Quick Access Toolbar provides easy access to
the commands you use most frequently. The Save,
Undo, Redo/Repeat, and Quick Print buttons appear
on the Quick Access Toolbar by default, but you can
add and remove commands to meet your needs.

Inspect Document
Removes comments,
tracked changes,
metadata (document
history such as the author
and editors) and other
information that you don’t
want to appear in the
finished document.

Microsoft Office Button

Restrict Permission
Uses Information Rights
Management (IRM) to
specify access
permissions.
Add a Digital Signature
Adding a digital signature
prevents inadvertent
changes, ensuring that
your content cannot be
altered.
Compatibility Checker
Checks for elements in a
document that aren’t
supported or will behave
differently in previous
versions of the program.
Mark As Final
Prevents changes by
making the document
read-only.
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Save

Undo

Repeat
Customize

Quick Print

• To Move the Quick Access Toolbar: Click the

Customize Quick Access Toolbar button on the
Quick Access Toolbar and, depending on the
location of the toolbar, select Place Quick Access
Toolbar below the Ribbon or Place Quick
Access Toolbar above the Ribbon from the
menu.

• To Add a Command to the Quick Access

Toolbar: Click the Customize Quick Access
Toolbar button and select Customize Quick
Access Toolbar from the menu. Select the
command you want to add, click the Add button,
and click OK. Or, on the Ribbon, right-click the
command you want to add and select Add to
Quick Access Toolbar from the contextual menu.

• To Remove a Command from the Quick Access
Toolbar: Right-click the command you want to
remove and select Remove from Quick Access
Toolbar from the contextual menu.
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Mini Toolbar

Save as PDF

The Mini Toolbar appears automatically whenever you select text and
contains common text formatting commands.

Now you can save a document as a PDF without using third-party software.
PDF format allows you to share your presentation with users on any platform

Font
type

Font
Size

Quick
Grow
Styles
Font
Shrink
Font

Bold

• To Save a Document as a PDF: Click the Microsoft Office Button point to
the Save As list arrow, and select PDF. Give the presentation a name,
select PDF in the Save as type list, and click OK. Click Publish.

Format
Painter
Bullets

Center
Italics

Increase
Font
Indent
Text Color
Decrease
Highlight
Indent
Color

Live Preview
Live Preview enables you to preview how a formatting change will look before
applying it. Simply point to a selection and Office 2007 shows you a preview of
what your document or object would look like if the selected changes were
applied.

• To Use the Mini Toolbar: Select the text you want to format and click the

desired command on the Mini Toolbar. Click anywhere outside the Mini
Toolbar to close it.
• To Turn Off the Mini Toolbar: Click the Microsoft Office Button and click
the Options button. Click the Personalize tab, uncheck the Show Mini
Toolbar on selection check box, and click OK.

Themes
A theme is a set of unified design elements that you can apply to a document
to give it a consistent look and feel. Themes coordinate the look of a document
using colors, fonts, and effects.

Simply point to a selection to preview how it will look in the document.

SmartArt Diagrams
SmartArt diagrams are dynamic diagrams that update automatically according
to the type of information you want to include.

• You can create SmartArt diagrams in Excel 2007, Outlook 2007, PowerPoint

•
•
• To Apply a Theme: Click the Page Layout tab on the Ribbon and click the

Themes button in the Themes group (Word/Excel) or click the Design tab
on the Ribbon and click the More button in the Themes group (PowerPoint).

•
•

2007, and Word 2007. Although you cannot create a SmartArt diagram in
other Office 2007 programs, you can copy and paste SmartArt diagrams as
images into those programs.
To Insert a SmartArt Diagram: Click the Insert tab on the Ribbon and click
the SmartArt button in the Illustrations group. Select the SmartArt type you
want to use and click OK.
To Add Text to a SmartArt Diagram: Click inside the Text pane and type
your text.
To Add a Shape to a SmartArt Diagram: In the Text pane, position the
insertion point where you want to add the shape and press <Enter>.
To Remove a Shape from a SmartArt Diagram: Select the shape you
want to remove and press <Delete>.

XML Compatibility
The new Microsoft Office Open XML format (.docx, .pptx, .xlsx, etc.) is based
on the XML (Extensible Markup Language) programming language. Here are
its main benefits:

• Safer documents: Documents containing unwanted code, macros, or
controls are easier to identify and block.

• Reduced file size: All Office 2007 documents are automatically
compressed.

• Improved information security: Personal and business-sensitive
information is easier to remove.

• Improved damaged-file recovery: A file can still be opened even if part
of it is damaged.

• Easier integration: Document content can be shared with and opened in
other programs.
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As you type your text
in the Text pane…

…Office 2007 inserts it into
the diagram automatically.
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